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Introduction 

Estimated time to complete this lab 

30 minutes 

Objectives 

In this lab, you will learn the fundamentals of using Windows PowerShell commands, known as cmdlets, 

including the following techniques: 

 Exploring Windows PowerShell Help 

Windows PowerShell has a powerful documentation mechanism. Administrators can query the 

help subsystem with a unified command set. Developers are provided with a set of common tools 

to lower the time invested in documentation. 

 Constructing a pipeline 

Windows PowerShell is different from other shells because it does not use strings as parameters; 

instead it uses .NET objects which can be navigated, processed, reflected, and formatted. 

 Using formatting commands 

Windows PowerShell does not limit the kind of formatting that can be applied to a simple object 

nor does it place any restrictions on the destination of the output. Developers can extend the 

wide range of available choices through the development of cmdlets. 

 Using filtering and sorting commands 

As a complement to formatting, filtering and sorting commands are very useful for cmdlet output 

manipulation. Windows PowerShell provides typical filtering and sorting cmdlets for most tasks, 

and developers can also extend them by creating new cmdlets. 

 Using -WhatIf and -Confirm 

These are common switches you can apply to cmdlets. 

 Working with variables 

Like any Windows-based scripting language, Windows PowerShell has variables too, but they are 

much more powerful than the variables in older scripting languages. Windows PowerShell 

variables are actually mapped to underlying classes in the Microsoft® .NET Framework. And in the 

Framework, variables are objects, meaning they can store data and also manipulate it in many 

ways. 

 Working with providers 

The provider represents a set of stored data (e.g. the Microsoft Windows Registry, the Windows 

file system, Active Directory) that can be accessed and navigated through Windows PowerShell 

commands. 
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Prerequisites 

Before working on this lab, you must have: 

1. An understanding of concepts such as virtual machines, virtual hard disks, and virtual networks. 

2. The ability to work in a command-line environment. 

Overview of the lab 

Windows PowerShell is a command-line shell and scripting language that helps IT professionals achieve 

greater control and productivity. Using a new admin-focused scripting language, more than 230 standard 

command-line tools, and consistent syntax and utilities, Windows PowerShell allows IT professionals to 

more easily control system administration and accelerate automation. 

Intended audience 

This lab is intended for network administrators who wish to learn the Windows PowerShell interface and 

language.  

Virtual machine technology 

This lab is completed using virtual machines that run on Windows Server 2012 Hyper-V technology. To 

log on to the virtual machines, press CTRL+ALT+END and enter the following credentials: 

 Username: Administrator 

 Password: Passw0rd! 

Computers in this lab 

This lab uses computers as described in the following table. Before you begin the lab, you must ensure 

that the virtual machines are started and then log on to the computers.  

Computer Role Configuration 

DC Domain controller Domain controller 

 All user accounts in this lab use the password Passw0rd! 

Note regarding pre-release software 

Portions of this lab include software that is not yet released, and as such may still contain active or known 

issues. While every effort has been made to ensure this lab functions as written, unknown or unanticipated 

results may be encountered as a result of using pre-release software.  

Note regarding user account control 

Some steps in this lab may be subject to user account control. User account control is a technology which 

provides additional security to computers by requesting that users confirm actions that require 

administrative rights. Tasks that generate a user account control confirmation are denoted using a shield 

icon. If you encounter a shield icon, confirm your action by selecting the appropriate button in the dialog 

box that is presented. 

Note on activation 

The virtual machines for these labs may have been built by using software that has not been activated. 

This is by design in the lab to prevent the redistribution of activated software. The unactivated state of 
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software has been taken into account in the design of the lab. Consequently, the lab is in no way affected 

by this state. For operating systems other than Windows 8, please press Cancel or Close if prompted by an 

activation dialog box. If you are prompted by an Activate screen for Windows 8, press the Windows key to 

display the Start screen. 
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Exercise 1: Exploring Windows PowerShell 

In this exercise, you will explore several Windows PowerShell commands and features including help, 

object formatting, and safety features. 

 Perform all the exercises on DC. 

 Every command has three different levels of help available: 

1. The default view shows the command description and syntax. 

2. The detailed view adds usage examples and complete documentation. 

3. The full view adds command’s technical details including parameter and return value 

data types. 

Reviewing the help available in Windows PowerShell 

In this step, you will learn how to view the different levels of help content available for a cmdlet. 

1. To open a new Windows PowerShell command window, on the taskbar, click Windows 

PowerShell. 

2. At the Windows PowerShell command prompt, type the following command, and then press 

ENTER to see a list of available help topics. 

↪ help * 

3. The command will fill an entire screen and then pause. Press ENTER to show the next output line, 

or press SPACE BAR to advance to the next page. 
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Figure 1: Executing the Help command 

 In the output you can see a second column with a value of Alias, Cmdlet, Provider, or HelpFile. An alias is 

an alternative name for a command, usually an abbreviation or a name used by other shells for similar 

functionality. Cmdlets are .NET classes that are exposed as APIs, commands, and GUIs. Providers are 

extensions to Windows PowerShell that provide features such as policy verification or metadata 

augmentation. Help files contain information for different topics, including command descriptions and 

topics on how to extend Windows PowerShell. 

4. Press SPACE BAR until the command prompt returns. Alternatively, you can type the letter Q to 

cancel the output. 

5. To view help information about the Get-Command cmdlet, at the Windows PowerShell command 

prompt, type the following command, and then press ENTER. 

↪ help Get-Command 

 The help contains the syntax for the command as well as a brief description. 

 

Figure 2: Obtaining help for the Get-Command cmdlet 

6. To see detailed help for the Get-Command cmdlet, at the Windows PowerShell command 

prompt, type the following command, and then press ENTER. 

↪ help Get-Command -Detailed 

 The output includes details about the parameters for the cmdlet, as well as some examples. 
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Figure 3: Obtaining help for the Get-Command cmdlet in detailed mode 

7. To view the entire help content for the Get-Command cmdlet, at the Windows PowerShell 

command prompt, type the following command, and then press ENTER.  

↪ help Get-Command –Full 

 

Figure 4: View the entire help content for the Get-Command cmdlet 
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 The full help for the cmdlet includes parameter data types and notes. This is a technical view of the 

command’s help. 

 Help regarding conceptual topics in Windows PowerShell begins with the prefix about_. To display help 

about a Windows PowerShell concept, type Get-Help followed by the concept name. To view a list of 

conceptual topics, type Get-Help about. 

List the commands available in Windows PowerShell 

In this step, you will list all available commands in Windows PowerShell. 

1. To view the list of available commands, at the Windows PowerShell command prompt, type the 

following command, and then press ENTER. 

↪ Get-Command 

2. Review the list of commands available. Take note of the naming convention for commands with a 

CommandType of Cmdlet. 

 

Figure 5: List of Windows PowerShell commands 

 Windows PowerShell uses verb-noun naming conventions to make cmdlets discoverable and obvious in 

what they do. 

3. At the command prompt, type the following command, but do not press ENTER. 

↪ Get-C 
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4. Press TAB. Windows PowerShell expands the command to Get-CAAuthorityInformationAccess. 

5. Press TAB again. The command is changed to Get-CACrlDistributionPoint.  

 If you do not see these cmdlets, make sure you are performing the steps on DC. 

6. You can continue pressing TAB to cycle through all the available commands that begin with  

Get-C. Similarly, you can cycle backwards by pressing SHIFT-TAB. 

 You can easily display a list of available Windows PowerShell commands. In addition, you can enter a 

portion of a command name and use tab-completion to resolve the partial command to a full Windows 

PowerShell command. 

7. Press ENTER to execute the expanded Windows PowerShell command. 

Format and filter output using Windows PowerShell 

In this step, you will learn how to use command parameters and cmdlets to filter data. Also, you will learn 

how to format the displayed output. 

1. To view a list of services installed on the computer, at the Windows PowerShell command prompt, 

type the following command, and then press ENTER. 

↪ Get-Service 

 A list of services is displayed. 

 

Figure 6: The Get-Service command 
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 Windows PowerShell provides a complete set of verbs to query and manipulate services, including Get, 

New, Restart, Resume, Set, Start, Stop, and Suspend. To view a list of service related commands type 

Get-Command  -Noun Service. 

2. Enter the following to view the status of the Spooler service: 

↪ Get-Service –Name Spooler 

 

Figure 7: Status of the Spooler service 

 The Get-Service command resolves the first input as the name parameter when you do not specify a 

parameter name for the input.   

3. Enter the following command to obtain the same result as the previous step. 

↪ Get-Service Spooler 

 You can use positioned or named parameters when you invoke cmdlets. Windows PowerShell provides 

built-in code that relieves cmdlet developers from having to parse program parameters. 

4. Type the following command, and then press ENTER to view a list of all services that begin with 

M. 

↪ Get-Service M* 

 The status of all the services beginning with M is shown. 

 

Figure 8: Status of the services beginning with M 

 Many cmdlets allow the use of wildcards. You can use the wildcard to filter the results to a subset of all 

results. 

5. Enter the following to see the same list of services. This time, the output is shown in list format. 

↪ Get-Service M* | Format-List 

mailto:labs@holsystems.com


Windows Server 2012 R2 – Windows PowerShell Fundamentals 

Lab created by HynesITe, Inc. For questions or comments, send an email message to labs@holsystems.com  Page | 12 

 

Figure 9: Using the format-list command 

 In this example, there are two commands separated by a pipe (|) character. This means that the output 

of the first command is used as the input to the second command. 

6. Enter the following to see the same output, this time shown in a custom format. 

↪ Get-Service M* | Format-Custom 

 The status of all services beginning with M will be shown in the custom format. 

 

Figure 10: Using the Format-Custom command 

 Windows PowerShell includes several defined format commands, each one with many configuration 

options. This provides a great deal of flexibility in output formatting. Developers can also create 

additional format commands. 
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7. Type the following command, and then press ENTER to view all the running services that begin 

with M. 

↪ Get-Service M* | Where-Object {$_.Status -eq "Running"} 

 Only services in a running state are shown this time. 

 

Figure 11: Using the Where-Object command to filter the list to show only running services 

 In this command: 

– Where-Object is a command for performing a filter on the input. 

– { } are delimiters for Windows PowerShell code blocks. 

– $_ refers to the input object (all services that begin with M). 

– -eq specifies that the left-hand argument, in this case the Status property ($_.Status), will be compared 

for equality against the right-hand argument, the value “Running”. 

8. To view all the stopped services that begin with M, type the following command, and then press 

ENTER. 

↪ Get-Service M* | Where {$_.Status -eq "Stopped"} 

 Only those services that are stopped are shown. 

 

Figure 12: Using the Where-Object command to filter the list to show only stopped services 

 This is an example usage of the alias mechanism. Here, Where is an alias for the Where-Object 

command. 

9. To view a list of all services ordered by their status, type the following command, and then press 

ENTER. 

↪ Get-Service | Sort-Object Status 
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 The Sort-Object command can order objects returned by a previous cmdlet using one or more of their 

properties. You can also use the alias Sort to refer to the Sort-Object command. 

10. Type the following command, and then press ENTER to view the Name and DisplayName of all 

services beginning with M, with the output ordered and grouped by Status. 

↪ Get-Service M* | Sort-Object Status | Format-Table -GroupBy Status 

Name, DisplayName 

 

Figure 13: Using the Sort-Object and Format-Table command to group the output data 

View object metadata 

Everything in Windows PowerShell is a .NET object, and is available for reflection, including cmdlets, 

services, and processes. Windows PowerShell extends the .NET type reflector to allow simpler access for 

administrative purposes. 

In this step, you will learn how to view the type members of those objects. 

1. To view the type metadata for the object output by the Get-Service command, type the following 

command, and then press ENTER. 

↪ Get-Service | Get-Member 

 The type metadata for the object output by Get-Service is displayed. Note that the data type, in this 

case the System.ServiceProcess.ServiceController class, is also displayed. 
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Figure 14: Using the Get-Member command to view object metadata 

2. To view the type metadata for the object output by the Get-Process command, type the following 

command, and then press ENTER. 

↪ Get-Process | Get-Member 

 

Figure 15: Members of the System.Diagnostics.Process type 

3. To create a new object of type System.Diagnostics.Process and view the type metadata for the 

class, type the following command, and then press ENTER. 

↪ New-Object System.Diagnostics.Process | Get-Member 
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 The type metadata for the System.Diagnostics.Process class is shown. 

  

Figure 16: Type members of a new object 

4. Type the following command, and then press ENTER to view a list of services that the Spooler 

service depends on. 

↪ Get-Service Spooler | Select-Object ServicesDependedOn 

 A list of services that the Spooler service requires to start is displayed. 

 

Figure 17: Inspecting the ServicesDependedOn property of the Spooler service 

Using Show-Command 

Metadata information can also be used to identify the inputs needed for a specific command and to 

retrieve information about the command. Windows PowerShell provides a graphical aid to provide the 

command input. 

In this task, you will learn how to retrieve and provide information needed in a graphical manner by using 

the Show-Command cmdlet. 

1. To view the input metadata for the Get-Service command, type the following command, and then 

press ENTER. 
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↪ Show-Command Get-Service 

 The input metadata fields for the Get-Service command are displayed. This is also an interactive window 

that allows you to type the necessary fields to retrieve information from local or remote systems. 

2. To view the results of Get-Service, in ComputerName, type localhost, and then click Run. 

3. Review the results of the execution of Get-Service with the value for the ComputerName 

parameter set to localhost. 

 

Figure 18: Get-Service with ComputerName set to localhost 

Using whatif and confirm 

Windows PowerShell allows administrators to safely test and use commands. In this step, you will use the 

whatif and confirm commands. 

 The [Command] -WhatIf flag shows you the results without actually performing the action.  

 The [Command] -Confirm flag asks you to confirm the operation before it executes. 

1. Type the following command, and then press ENTER to see a list of services that would be 

stopped if you ran the Stop-Service command. 

↪ Stop-Service M* -WhatIf 

 A list of services that would be stopped is displayed. 

  

Figure 19: The Stop Service command with the WhatIf flag specified 
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2. Type the following command, and then press ENTER to confirm whether or not to stop each 

service. 

↪ Stop-Service M* -Confirm 

 For each service beginning with M, you will be asked if it should be stopped. For this lab, reply No in 

each case. 

  

Figure 20: The Stop-Service command with the confirm flag specified 

Creating and manipulating variables 

In this step, you will work with variables in Windows PowerShell. You will learn about their declaration, 

usage, and behavior. 

1. To create a variable to hold a string value, type the following command, and then press ENTER. 

↪ $var = "Hi there" 

 With this command, you created a variable named var, and you assigned the string value Hi there to it. 

 A variable in Windows PowerShell must begin with the dollar sign ($). If special characters are needed in 

a variable name, curly braces can be used to surround the variable name ({}). 

2. To output the value stored in this variable, type the following command, and then press ENTER. 

↪ $var 

 A better way to output variable values is to use a cmdlet named Write-Host before the variable name, 

clearly showing it will output the values to the host. 

↪ Write-host $var 

The results should be similar to the following screenshot. 

  

Figure 21: Printing a variable value 
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 By default, a variable will have a null value. Null values in Windows PowerShell are represented as $null. 

3. Variables in Windows PowerShell can be listed and accessed under a special location. To display 

the list of currently declared variables, type the following command, and then press ENTER. 

↪ Get-Variable 

  

Figure 22: List of currently declared PowerShell variables 

4. By default, variables in Windows PowerShell are non-typed, which means they can hold an 

arbitrary value. To change the variable value and type to an integer, type the following command, 

pressing ENTER after each line. 

↪ $var = 123 

↪ $var 

 Now the variable is holding the integer value 123. 

  

Figure 23: Assigning an integer value 

5. Variables can also contain lists (similar to arrays). To change the value to an array of integers, type 

the following commands, pressing ENTER after each line.  

↪ $var = 1,2,3 

↪ $var 

 This time, the variable is holding an array of integers. 
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Figure 24: Creating an array of integers 

6. To see the new type of the variable, type the following command, and then press ENTER. 

↪ $var.GetType().FullName 

 The variable is now an array object of type System.Object[]. 

  

Figure 25: Obtaining the type of the variable 

 Arrays can be also manipulated through their .NET methods. For example, they can be queried on their 

length.  

7. To use the Length property to retrieve the number of elements of the array, type the following 

command, and then press ENTER. 

↪ $var.Length 

 The size of the array is displayed. 

  

Figure 26: Displaying the array length 

8. You can also access individual elements within an array by using square brackets ([]). To retrieve 

the second element of the array, type the following command, and then press ENTER. 

↪ $var[1] 

 Arrays in Windows PowerShell are zero-based, which means that the first element will always be at 

position (index value) 0. 

 The value of the second element of the array is displayed. 

  

Figure 27: Retrieving an element of the array 
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9. You can also type a variable by prefixing its declaration with the desired data type name. To re-

declare the variable as an array of integers, type the following command, and then press ENTER. 

↪  [int[]] $var = (1,2,3) 

10. To assign the string value 0123 to the third element of the array, and then display it, type the 

following commands, pressing ENTER after each one. 

↪ $var[2] = "0123" 

↪ $var[2] 

  

Figure 28: Implicit conversion from string to integer 

 Examining the output of the variable, the string 0123 was converted into the number 123. Windows 

PowerShell implicitly converted the stored value to match the destination variable type. 

 Implicit type conversions are done only for typed variables. Unlike strongly typed languages where a 

variable can only be assigned an object of the correct type, Windows PowerShell allows the assignment 

of any object, as long as it is convertible to the target type, by the extensive use of implicit conversions. 

11. When an implicit conversion is not available, it displays an error. To attempt to set a string value 

that cannot be converted, type the following command, and then press ENTER. 

↪ $var[2] = "A string value" 

 The following error is displayed. 

  

Figure 29: Type conversion error 

Working with strings 

In this step, you will use different operators to deal with strings values in Windows PowerShell. 

1. To create and initialize two string variables named var1 and var2, type the following commands, 

pressing ENTER after each one. 

↪ $var1 = "Hello " 
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↪ $var2 = "world" 

2. To use the plus (+) operator to concatenate the two string variables, type the following command, 

and then press ENTER. 

↪ $var1 + $var2 

 The result of this operation is a new Hello World string, as shown in the following screen shot. 

  

Figure 30: Concatenating two string variables 

 Windows PowerShell defines the behavior of the + operator for numbers, strings, arrays and hash 

tables. Adding two numbers produces a numeric result following the numeric widening rules. Adding 

two strings performs a string concatenation, resulting in a new string, and adding two arrays joins the 

two arrays (array concatenation). 

3. You can use the .NET String properties to inspect the string objects. To use the Length property to 

obtain the size in characters of the previous string concatenation, type the following command, 

and then press ENTER. 

↪  ($var1 + $var2).Length 

  

Figure 31: Using the Length property 

4. Windows PowerShell also provides other kinds of binary operators, like comparison operators. To 

verify if two strings are equal, type the following command, and then press ENTER, 

↪ "John Smith" -eq "John Sanders" 

 The result of the comparison is shown in the following screen shot. 

  

Figure 32: Comparing two strings 

  There are other comparison operators, like –ne (not equals) –gt (greater than), –lt (less than),  

–ge (greater than or equal) and –le (less than or equals). 

mailto:labs@holsystems.com


Windows Server 2012 R2 – Windows PowerShell Fundamentals 

Lab created by HynesITe, Inc. For questions or comments, send an email message to labs@holsystems.com  Page | 23 

 For each of these operators there is also a base or unqualified operator form, like –eq and its two 

variants –ceq and –ieq. The “c” variant is case-sensitive and the “I” variant is case-insensitive. 

5. Formatting is a common task that can also be done in Windows PowerShell. To use a custom 

format to display 12.4 as 12.40, type the following command, and then press ENTER. 

↪ "{0:f2}" -f 12.4 

 The output should look like the following screenshot. 

  

Figure 33: Formatting decimal values 

6. To display the same number as currency, and then to pad it to 10 characters aligned to the right, 

type the following command, and then press ENTER. 

 Use the vertical bars to see the added padding: 

↪ "|{0,10:C}|" -f 12.4 

 The currency symbol configured in the current culture of the local machine is used. 

  

Figure 34: Formatting currency values 

7. Date and time formatting can also be done. To display only hours and minutes from the current 

date, type the following command, and then press ENTER. 

↪ "{0:hh:mm}" -f (Get-Date) 

  

Figure 35: Formatting date and time values 

Creating a script file 

Script files are used to store Windows PowerShell commands in a file, providing an easy way to run a list 

of commands. You only need to tell Windows PowerShell to run the script file. 

In this step, you will learn how to create and run script files. To understand the reasons behind the 

security features of Windows PowerShell, you will be introduced to a Windows PowerShell security feature 
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called execution policies. The execution policy enables you to determine which Windows PowerShell 

scripts (if any) will be allowed to run on your computer. Windows PowerShell has four different execution 

policies: 

 Restricted – No scripts are allowed to run. Windows PowerShell can only be used in interactive 

mode. 

 AllSigned – Only scripts signed by a trusted publisher can be run. 

 RemoteSigned – Downloaded scripts must be signed by a trusted publisher before they can be 

run. 

 Unrestricted – No restrictions; all Windows PowerShell scripts can be run. 

 When you first install Windows PowerShell, the default value for the execution policy will be set to 

Restricted. 

1. To display the current execution policy, type the following command, and then press ENTER. 

↪ Get-ExecutionPolicy 

  

Figure 36: The current execution policy is displayed 

2. Before running a script file, you will have to change the execution policy. To change the execution 

policy to RemoteSigned and verify the change, type the following commands, pressing ENTER 

after each one. 

↪ Set-ExecutionPolicy Unrestricted 

↪ Get-ExecutionPolicy 

 Changing the execution policy requires administrative privileges. If you are running Windows Vista or 

Windows 7, on the Start menu, right-click the Windows PowerShell icon, and then click Run as 

Administrator.  

 For other platforms, either log in with an administrative account or open a Windows PowerShell console 

by using the runas command and supplying appropriate credentials. For example: 

runas /user:username PowerShell 

where username is an account with administrative privileges. 

Remember that it is best practice to use administrative privileges only for operations that require it. 
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Figure 37: Changing the execution policy 

 More information on Windows PowerShell security can be found at: http://technet.microsoft.com/en-

us/magazine/2007.09.powershell.aspx. 

3. To create the script file, on the taskbar, right-click the Windows PowerShell icon, and then click 

Windows PowerShell ISE.  

 To create script files, you don’t need a special editor. In this example you will use the Windows 

PowerShell Integrated Scripting Environment (ISE). The Windows PowerShell ISE is a host application 

that enables you to run commands, write, test, and debug scripts in a friendly, syntax-colored, Unicode-

compliant environment. 

4. On the View menu, click Show Script Pane. 

 The ISE has two windows, or panes, so you do not need to edit text in a separate application. 

 The script pane at the top allows you to compose, edit, debug, and run functions and scripts. 

Note that the script pane is not displayed by default. To display the script pane, on the View 

menu, click Script Pane. 

 The console pane at the bottom is used for running interactive commands, just as you would 

in the Windows PowerShell text-based console. 

5. In the script pane, type the following commands, pressing ENTER after each line. 

↪ # test.ps1 

↪ # Show Hello and time. 

↪  

↪ "" # Blank Line 

↪ "Hello " + $env:UserName + "!" 

↪ "Time is " + "{0:HH}:{0:mm}" -f (Get-Date) 

↪ "" # Blank Line 

6. To save the file as a Windows PowerShell script file, on the File menu, click Save As.  

7. In the file name, type test.ps1, in the location, type C:\users\Administrator\Desktop, and then 

click Save. 

 When you create your script file, the filename must have a .ps1 extension.  

8. Click in the command pane, type the following command, and then press ENTER.  

↪ cd C:\users\Administrator\Desktop  

9. To execute the script file you created in the previous step, type the following command, and then 

press ENTER. 

↪ .\test.ps1 
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 You can follow the same procedure to execute scripts in the Windows PowerShell text-based console. 

From the ISE, you can also execute a script using the Run command on the File menu. 

 Preceding the script name with directory information, in this case the current directory (.\), instructs 

Windows PowerShell to run a script. 

 There must be no space between .\ and the script name. Adding the .ps1 extension is optional. You 

must specify the path to the script file, even if the script is in the current directory. 

  

Figure 38: Running the script file from the current directory 

10. To use the Invoke-Expression command as an alternative way of running the same script, type the 

following command, and then press ENTER. 

↪ Invoke-Expression "C:\Users\Administrator\Desktop\test.ps1" 
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Figure 39: Running the script file using Invoke-Expression 

11. To use the invoke operator (&) to execute the command in the string that follows, type the 

following command, and then press ENTER. 

↪ & "C:\Users\Administrator\Desktop\test.ps1" 

 

Figure 40: Running the script file using ampersand (&) 

12. To close the test.ps1 script, on the test.ps1 tab, click the X. 

 As an alternative, on the File menu, click Close. 
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 Many commands in the ISE have keyboard shortcuts. You can see the keyboard shortcuts to the right of 

their respective commands in the menus at the top of the ISE. The keyboard shortcut to close the active 

file in the script pane is Ctrl+F4. 

Creating functions 

In Windows PowerShell, you can declare functions. Functions are reusable pieces of code that can be 

called as many times as you want after you declare them. 

In this step, you will declare a function, learn about using different types of parameters, and specify 

default values for these parameters. 

1. In the Windows PowerShell ISE, press CTRL+N. 

2. In the script pane, type the following code. 

↪ function Get-Soup ( 

↪     [switch] $please, 

↪     [string] $soup = "chicken noodle" 

↪ ) 

↪ { 

↪     if ($please) { 

↪         "Here's your $soup soup" 

↪     } 

↪     else { 

↪         "No soup for you!" 

↪     }   

↪ } 

 This command declares a Get-Soup function which will receive two parameters, $please and $soup. 

3. To run the script, press F5, and then click the Script arrow to hide the script pane.  

 It is not necessary to save a script before executing it in the ISE. This makes it easy to use the script pane 

to quickly test commands and code snippets. 

4. To call the script with no parameters, in the command pane, type the following command, and 

then press ENTER. 

↪ Get-Soup 

5. To call the Get Soup function with the $please parameter, type the following command, and then 

press ENTER. 

 To specify a parameter declared as a switch, specify –parameter name after the function name. 

↪ Get-Soup -please 
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 Since you didn’t specify a value for the $soup parameter, the default value (chicken noodle) is used. 

6. To call Get-Soup specifying a value for $soup, type the following command, and then press 

ENTER. 

↪ Get-Soup –please tomato 

Working with providers 

Windows PowerShell providers enable you to access data that would not otherwise be easily accessible at 

the command line. The data that a provider exposes appears in a drive, much like a hard drive, and is 

presented in a consistent format that resembles the file system. You can use any of the built-in cmdlets 

that the provider supports to manage the data in the provider drive, in addition to custom cmdlets that 

are designed especially for the data. By default, Windows PowerShell includes several providers that allow 

you to access common data stores in Windows, such as the file system, registry, and certificate store. 

In this step, you will list the available providers and the drives which make use of these providers. You will 

also create a new drive using the registry provider. 

1. On the taskbar, click Windows PowerShell. 

2. To display a list of the available providers, type the following command, and then press ENTER. 

↪ Get-PSProvider 

  

Figure 41: List of Windows PowerShell providers 

3. To display a list of the available drives, type the following command, and then press ENTER. 

↪ Get-PSDrive 

  

Figure 42: List of Windows PowerShell drives 
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4. To create a new drive for the HKEY_CLASSES_ROOT hive in the registry using the Registry 

provider, type the following command, and then press ENTER. 

↪ New-PSDrive -Name HKCS -PSProvider Registry -Root 

"HKEY_CLASSES_ROOT" 

  

Figure 43: Adding a new Windows PowerShell drive 

 As with the file system, the registry can also be modified using Windows PowerShell drives. Be aware 

that when modifying the registry, changes may cause the system to fail. 

5. To browse to the newly created drive, called HKCS, as if you were working with a drive in the file 

system, type the following commands, pressing ENTER after each one. 

↪ cd HKCS: 

↪ dir .ht* 

 This will set the current location to the newly created HKCS drive, and then display the list of registry 

entries that match the filter expression. 

 IMPORTANT: The trailing colon (:) after the drive name indicates a drive change which is different from 

a folder change. The colon is necessary; otherwise, Windows PowerShell will display an error. 

  

Figure 44: Browsing the HKCS drive 

6. To change the current folder to another folder inside the HKCS drive, and then list its contents, 

type the following commands, pressing ENTER after each line. 

↪ cd .html 

↪ dir 
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Figure 45: Listing a key of the registry as if it were a folder in the file system 

 Many of the same commands used to manipulate the file system, such as cd and dir, also work with 

other providers. 
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Exercise 2: Working with Windows PowerShell ISE 

You can use the Windows PowerShell Integrated Scripting Environment (ISE) to create, run, and debug 

commands and scripts. The Windows PowerShell ISE consists of the menu bar, Windows PowerShell tabs, 

the toolbar, script tabs, a script pane, a console pane, a status bar, a text-size slider and context-sensitive 

Help. It works for both local and remote scripts. 

Using the Windows PowerShell ISE gives you many different advantages when creating scripts. Although it 

can be used for interactive commands, the best use of the tool is for script creation and debugging. 

Getting to know Windows PowerShell ISE 

In this step, you will explore the layout of Windows PowerShell ISE. 

1. To open a new Windows PowerShell ISE environment window, on the taskbar, right-click 

Windows PowerShell, and then click Run ISE as Administrator. 

 

Figure 46: Windows PowerShell ISE 

2. On the View menu, click Show Script Pane. 

 The command pane to the right shows a list of commands based on the modules that are currently 

loaded. 
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Figure 47: Windows PowerShell ISE with the script pane displayed 

The script pane and IntelliSense in Windows PowerShell ISE 

In this step, you will learn how to use IntelliSense in the Windows PowerShell ISE script pane. 

1. In the script pane, type Get-.  

2. As you type, you will see a list of possible commands. Continue typing Get-Ser.  

 Get-Service will be selected and the possible complete syntax will be displayed.  

3. Press TAB. 

4. Press SPACE BAR. 

5. Type -.  

 A list of possible parameters will appear.  

6. Continue typing Computer, press TAB, and then press SPACE BAR. 

7. Type DC. 

8. Press F5 to execute the command. 
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The command pane in Windows PowerShell ISE 

In this step, you will use the command pane in Windows PowerShell ISE. 

1. In the command pane, in the Name box, type Get-Service. 

 As you type, the commands will be filtered. 

2. In the filtered results, click the Get-Service command. 

 The parameters for the command will appear. Review the Default, DisplayName, and InputObject tabs. 

3. In the ComputerName parameter, type DC, and then press F5 to run the command. 

 Review the results of all available services on the target system. 

4. In the Name parameter, type TermService, and then press F5 to run the command. 

5. In the command pane, select the Insert option. 

 The command will be inserted into the interactive Windows PowerShell console pane. 

6. Expand Common Parameters. 

7. Review the parameters list. 

Snippets in Windows PowerShell ISE 

The script pane in Windows PowerShell ISE has predefined blocks of code that assist you in creating your 

scripts. Those blocks are called snippets. In this step, you will use snippets in the Windows PowerShell ISE. 

1. In the script pane, delete any existing lines. 

1.2. In the script pane, type the following command, and then press ENTER. 

↪ $process = Get-WmiObject –Class win32_process 

2.3. To access the snippets, press Ctrl+J, type foreach, and then press TAB. 

 The following block will be displayed: 

foreach ($item in $collection) 

{ 

} 

3.4. Replace $collection with $process. 

4.5. Inside the script block, in between the curly braces, type the following command: 

↪ $item.name 

5.6. The complete script block will be: 

↪ foreach ($item in $process) 

↪ { 
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↪  $item.name 

↪ } 

6.7. Press F5 to execute the script. 

 A list with the running processes in the system will be returned. 

 

This is the end of the lab 
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